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1 Overview

The purpose of this configuration guide is to describe the steps needed to
configure the Cisco PBX for proper operation Optimum Business Sip Trunking.

2 SIP Trunk Adaptor Set-up Instructions

These instructions describe the steps needed to configure the LAN side of the
Optimum Business SIP Trunk Adaptor.

Step 1:
Log on to the Optimum Business SIP Trunk Adaptor

1. Connect a PC to port 4 of the Optimum Business SIP Trunk Adaptor,
the silver device labeled Edgewater Networks, 4550 series.

B

s B o ATe
4550 SERI
e
R ) A

2. Open a Web browser and go to IP Address
http://10.10.200.1. A login box will appear.

3. Enter login and password and click ‘OK.
Login: pbxinstall
Password: s1ptrunk

Step 2:
Click on the LAN Settings Link

1. Assign an IP Address to the LAN interface of the SIP Trunk Adaptor.
The IP address must be on the same subnet as the IP PBX. This changes
the address on port 1 of the Optimum Business SIP Trunk Adaptor.

Note: This will become your local SIP

proxy |IP address. No other IP addresses | optimum. et =
will be provided by Cablevision. s | oo
2. Optional: Specify a VLAN for your ?z_:—%-' e w
voice traffic. Click the ‘Enable Voice e o
VLAN Tagging’ check box. The default ' o000
VLAN IDis 100. el

Note: VLAN 200 should not be used.
It is dedicated to port 4 for management.
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3. Optional: Enable the DHCP server. This will allow the SIP Trunk Adaptor to
act as a DHCP server, which will provide IP addresses to the voice network,
and create a dedicated voice LAN, as per diagram 2.

4. Click ‘Submit’.

Diagram 1 SIP Trunk Adaptor for IP-PBXs
Example: Single LAN Configuration
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Using a connection from the customer’s LAN, the SIP Trunk Adaptor’s address can be
a statically assigned private IP address. It may not be assigned a Public IP address.

Diagram 2 SIP Trunk Adaptor for IP-PBXs
Example: Separate Voice and Data Networks Configuration
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' The customer attaches their Voice Switch to the Ethernet LAN port 1 on the
X

Optimum Business SIP Trunk Adaptor. The Optimum Business SIP Trunk Adaptor
can be enabled as a DHCP server to provide routing for the separate voice network.
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Step 3:
Click on the SIP Trunk Configuration Link

1. Select your IP PBX make p—
Mimum- SIP Trunk Configuration
and model from the
Select your PBX: e =
d rop-down menu. Menu = Passive connection using the local, private IP address of the PBX
. customer o g b o At ol 0 TS
. e Pex Address:
2. Specify how the IP PBX T
. . :w ® Active connection using registration
will register to the User 1d: s
. : Password: eesesees
Optimum Business
Sl P _I_ k Ad t Convert Inband DTMF: o
run aptor. -

3. The Cablevision network p—

only supports Inband DTMF. Trunk Seatus: —

Click on the check box oios

T
next to “Convert Inband e
DTMF" if you cannot i -

configure your IP PBX to

send out Inband DTMF. The DTMF tone duration generated by the phones
and/or PBX may need to be increased from their default setting. Some
phones and/or PBX have a default setting between 180ms to 200ms. This
setting is too low. The recommended setting is 600ms.

4. Click ‘Submit’.
Step 4:
. . . Network Test Tools telo
Dlag nostics Link optimum. A network administrator may use the test tools on this page to verify
oo:cvecrt‘:vkv of the System and trace the path of data throughout the
E—
You can make a test call directly e e
e his test will lace a cal o the providec telephone number and play a series of ones for 30
from your phone or use the test | s et |
. . et o8 Pilot Number:
call application under the — Telzphone Number:

(=]

Inbound Call Test:

When this test is enabled calls received for the pilot number are diverted to the interal Test
UA for 15 minutes, after this elapsed time the test is automatically disabled.

« Enabled

# Disabled

[E=0)

Ping Test:
1P Address to Ping:

Traceroute Test:
1P Address to Trace:

Diagnostics link.
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Step 4 continued

Field Description

Outbound Call Test Specifies an outside phone number to which an outbound call

TelephoneNumber will be initiated. The pilot telephone number of the SIP Trunk will
be prepopulated.

Pilot Number Displays the provisioned pilot number, which is used for outbound
and inbound call tests.

Call Initiates a call outbound to a telephone number entered or inbound
to the pilot number displayed.

Inbound Call Test Indicates whether inbound test call will be enabled or disabled. If

(radio button) inbound test calls are enabled, calls made to the pilot number will be
redirected to the test UA for fifteen minutes. When the pilot number
is dialed, you will hear a test message play.

Submit Enables or disables the inbound call test.

IP Address to Ping Verifies basic connectivity to a networking device. Successful ping
test results indicate that both physical and virtual path connections
exist between the system and the test IP address.

Ping Button Sends a ping to the IP address specified in the field “IP Address
to Ping”.

IP Address Tracks the progress of a packet through the network. The packet can

to Trace be tracked through the WAN or LAN interfaces of the adaptor.

Interface Indicates whether a packet will be tracked through the LAN or

(radio button) the WAN.

Traceroute Initiates a traceroute to the specified IP address on either the LAN

Button or the WAN.

Reset Clears all fields and selections and allows you to enter new information.
Reset applies to outbound call test, ping and traceroute.
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3 Additional Set-up Information

Systems
Help
0} System
optimum.
N Software Version:
Confiquration Version 11.6.14.1 - Fri Jan 4 17:49:28 PST 2013
ersion .0. o T Jan . -
+ Customer Hostname:
*LAN Settings 5164939899
JSIP Trunk
*Dizgnostics Model:
»System EdgeMarc 4552
Vendor:
Cablevision

LAN Interface MAC Address:
AB:70:A5:00:D8:18

Registration Status:
The ALG feature is registered. View license key.

System Date:
02/29/2016 15:03:40 UIC

Change Password:
« pbxinstall

Description

Pbxinstall Link Select to change the default password for the pbxinstall login ID.
Only the password can be changed. The login ID cannot be changed.

Help
° Set Password
optimum. o
Change the GUI password by filling in the fields below. The password
must be between 6 and 8 characters in length.
Configuration i
Menu Username: pbxinstall
o @i Current Password:
»LAN Settings New Password:
»SIBTrunk Confirm Password:
’m. e
Dt
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ela e . o
Username Specifies the username for which the password can be changed.
Current Password Specifies the current password.
New Password Specifies the new password.
Confirm Password Confirms the new password.
Submit Applies the settings configured on this page.
Reset Clears all fields and selections and allows you to enter new information.

4 International Calling

Optimum Voice Business Trunking offers an optional International Calling Service

for direct-dialed calls made from the Customer’s business or from any phone via the
Optimum Voice International Calling remote access number to destinations outside of
the United States, Puerto Rico, Canada and the U.S. Virgin Islands at per minute rates.
The Customer must login to the Optimum Business Account Center and activate the
service on the Optimum Business Trunk Pilot telephone number to activate the service
and manage the monthly International spending limit for the account.

Activating International calling on the Pilot TN will enable International calling for all
Direct Inward Dial (DIDs) telephone numbers as well. Blocking International calling for
one or more DIDs is managed by the customer directly from the PBX phone system
configuration. To minimum the exposure to fraudulent calling, It is recommended to
limit International calling capability to those DID’s that require it and set up an account
spending limit that reflects what is necessary to run the business.

It is the Customer (and/or the Customer Agent’s) responsibility to properly secure
the customer’s PBX to prevent the PBX from being compromised and fraudulent calls
from being made by unauthorized (internal or external) users. If fraudulent calls are
detected, Cablevision reserves the right to disable International Calling until the
PBXis properly secured by the customer.
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5 PBX Configuration

The steps on the next pages describe the minimum configuration
required to enable the CME PBX to use Optimum Business SIP Trunking
for inbound and outbound calling. Please refer to the Cisco CME product
documentation for more information on other advanced PBX features.

The configuration described here assumes that the PBX is already
configured and operational with station side phones using assigned
extensions or DIDs. This configuration is based on Cisco 2901, I0S
version 15.1(3)T (c2900-universalk9-mz.SPA.151-3.T.bin) with built-in
CME v8.5.




The Cisco 2901 came with two Etherent ports, GE 0/0 and GE 0/1, with GE

0/0 defaults to an IP address of 10.10.10.1/248. One of these two Ethernet ports

and the Optimum Business SIP Trunk Adatpor’s LAN port 1 should be in the same

LAN segment. The GE 0/0 port and the Optimum Business SIP Trunk Adaptor’s LAN
port 1 have been assigned with IP addresses of 10.10.10.1/248 and 10.10.10.2/248
respectively. The GE 0/1 port has been assigned with an IP address of 192.168.0.1/24
and it will be used as the PBX's LAN port for communicating with the IP phones, as
well as the DHCP server for the IP phones.

Before you can configure the CME PBX for SIP trunk services, you need to download
and install the Cisco Configuration Professional (CCP) GUI on a Windows PC. As

of this writing, CME 8.5 and CCP 2.4 are the latest software available. If you have

a problem getting CCP 2.4 to work on your Windows PC, check the release notes
(i.e.: certain versions of the Java Runtime Environment may require certain settings in
order for CCP 2.4 to work). After CCP 2.4 has been successfully installed, connect the
Windows PC to the 10.10.10.0/248 LAN segment and start the CCP GUI.

[ Ea— - |

mm
cisco

Cisco Configuration Professional

1. From the “Select/Manage Community” screen, enter the CME PBX info in
the first entry of the devices to be discovered.
a. Enter the PBX’s IP address in the “IP Address/Hostname” field.

b. Enter the username in the “Username” field.

c. Enter the password in the “Password” field.
d. Check the checkbox next to the password field.
e. Click the “OK” button.
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) Home || (0] configure || Bl Monitor | ofe + = €)  cisco Configuration Professional

Select Community Member:
- = «  Home > Community View

Cisco Configuration Professional News

| Community Viaw Date e
22-1u-2010 Provide CCP Feedback

. [
; Ll oy B
I Entar information for up to 5 devices for the selected community
RS 1P Address/Hostname  Usemame Password Connect Securely
1 10.30.10.1 admin Y@
}
‘ 2 e |
3 e |
El De
3 e
(] Discover all devices oK Cancel

Manage Devices Discovery |

2. Click the “Discover” button.

f@mn.m Emm« \ * vy &2 @ Cisco Configuration Professional

T —
: «  Home > Community View

Mo devices discovered) | w

Date

22-Jul-2010

Community Information
Selected Community: New Community .Select 3 device from the table below. Use the buttons st the bottom to continue.

1 DfFitee: | 1 rovs retrieved |

1P address / Hostname. Discavery Status

¥ Fiash File Manageiricnt
¢ Configuration Editor

&¥8ave Configuration to PC

4/ Write to Startup Configuration

Preinat

wcovery Detasls ancel Discover outer status
o reload Deviee | omcover || o v Detas | | cancel O v | | Routerstat

3. Click the “Yes” button.




Home > Community View
Cisco Configuration Professional News
Date Title

22-3u1-2010 Provids CCP Fesdback

Security Certificate Alert E3)

Information you exchange with this router 10.10.10.1 cannot be viewed
B or changed by others. However, there is a problem with the router's
security certificate.

The security certificate was issued by a company you have not

© chosen to trust. view
10 trust the certifying authority.

ot uttons at the bottom to continue.

| 1 rove retrieved |
€© The security certificate has not expired and is still valid. Dicaary B |
© The name of the security certificate doesn't match the site name.

O Are you willing to accept the certificate asserting 10.10.10.1 a trusted
site?

(see J[s0 ][ arwmr ][ viowcomtions |

Router Status |

4. CCP has discovered the CME PBX. Click the “Configure” button to start
configuring the PBX.

Cisco Configuration Professional

Home > Community View

Date

22-Jul-2010

‘Community Information

Selacted Cammunity: New Cammunity .Select a device from the table belov. Use the buttns at the bottam to continue.
D‘:». | 1 rous retrieved |
| 1P address / Hostname

Discovery Status

/#Flash File Management
o Configuration Editor

" Save Configuration to PC

/" Wiite to Startup Configuration
P Teinet

¥ Relozd Device

5. Navigate to “Configure”>”Interface Management”->"Interface and

Connections” to set up the GE 0/1 Ethernet port needed for the PBX to
communicate with the IP phones.

a. Select the “Edit Interface/Connection” tab to make sure the
GE 0/1 port is not in use.



Select Community Member:

¥ 5 Interface Management

‘ ‘is:’ Q ad 8 Cisco Configuration Professional

Configure > Interface > Interface and

Interfaces and Conne:

Create Connection | Edit

mmm
cisco

s
() Enargywise

» (3 Router

» (3 Security

» (& Unified Communications

/*Flash File Management

/* Configuration Editor

7 Save Configuration to PC

/" Wirite to Startup Configuration
o Telnat

/*Raload Device

@ Edt A0~ [ Delete| @ Summary |G Detals & Test Connection @ Disable

Status | Description

t
no IP address GigabitEthernet

Details about Interface-GigabeEthernet0/0

ftem Name ftem Yalue

<None>
Access Rule - inbound <None>
Access Rule - outhound <None>
IPSes Policy <None>
Inspect Rule - Inbound <Nane>
Inspect Rule - outbound <Nane>
Easy VPN Remote <None>
Q08 policy - outbound <None>
Q08 Policy - inbound <None>
0

6. Select the “Create Connection” tab to set up the GE 0/1 Ethernet port,
select the radio button for “Ethernet LAN” and then click the “Create New
Connection” button.

Cisco C

¥ 5 Interface Management
_]Interface and Connections.
[ Eneraywise

» & Router

» 3 Security

b (3 Unified Communications

/*Flash File Managemant
o Configuration Editor
/" Save Configuration ta PC

/*Write to Startup Configuration
o Telnat
4/ Reload Device

»Bavien

Interface and

Create Connection | Edit nterfacs/Connection |

Creste New Connection
Use Case Scenario

& Ethemet LAN
€ Ethernet (PPROE or Unencapsulated Routing)
Information

Cenfigure Ethernet LAN interface for straight
routing and 802,19 trunking

How dol:  How Do | Configure an Unsupporied WAN interface?




7. Click the “No” button from the “Enable AAA” screen.

EMW | %‘S’ (:i ot @ Cisco Configuration Professional

Configure > Interface Management > Interface and Connections

&
=, Interfaces and Connections

v £ tnterface Management T e
e Create Connection | Edi Inerfareicanneciion |
Create New Connection

[ Energywise Use Case Scenario
|+ Router Select 8 connedtion and didk Create New Connestion

(% Ethemet LAN

 Eihermet (PPPOE o Unencapeuisied Routing) g_
uw
formatin o]

Configura Ethamat LAN interface for straight Q_

routing and 202.1a trunking

Enable AAA E

I @ The Ethernet LAN wizard allows you o optionally enable 802.1x
Authentication on the selected LAN inferface.

802 1x Authentication requires AAA to be enabled on the router.

Da you want ta enable A%A on the router so that you ean configure B021x
Authentication on the LAN interface?

/" Flash File Management
/* Canfiguration Editor
*Save Configuration to PC
/7 Wiite to Startup Configuration T ———
o Telnat Create New Connection
o Reload Device

»Bivien

TR

o |

How do1:  How Do | Configure an Unsupported WAN Interface?

8. Click the “Next »” button.

Interfaces and Connections:

Create Connection | Edit interface/Connection |

L Interfaca and Connaction=
B Fracmiie - ﬂ.
LAN

» 24 Router
» (2 Securty

¥ B Interface

@ EmemetLan Layer 3 Ethernet Interface Configuration

» (23 Unified Communi Ll

information .

Contigura Btharvit This wizard will guide you through Layer 3 Etnermet and VLAN interface creation process.

Ciseo CP also i i N a5 3 DHCF server

£Flash File Managemant
P contia
P Seve Configuration o BC

i Editor

o Wit b Startup Configuration
Pranet Create tew Connection
//Reload Davice

e

Howdol:  How DolConf

<Back | Next» | Finsn | Cancel| Help

9. Click the “Next >” button.
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elp

Sslszt Community Mambar:
“  Configure > Interface Management > Interface and Connections

Interfaces and Connections.

ate Connection | EditInterfacelConnection

Create New Connecton

and{ LAN Wizard

v B9 interface Management
_jInterface and Connections

[ Energywise
» & Routar
3=}

B3 Unified Communications

@ Enamet LAN
 Einemet (PPRE or

Ethernet Canfiguration

& Configure this intertace for straight routing
 Configure this inferface for 802.10 runking

Information 3

Configure Etharnst LA
Informetion

Straight routing cenfigures enly physical main interface. No
subinterface/VLAN can be created under this made,

File Mansgement

o Configuration editar

/*Sava Configuration ta PC
 Write to Startup Canfiguration
A Teinet Create New Cannection
P Relosd Device

»Qivien

Howdal:  How Do | Con

<Back | Next» | Fiich | Cancel| Help

10. Enterthe IP address for the GE 0/1 port in the “IP address” field,
enter the subnet mask in the “Subnet mask” field and then click
the “Next >” button.

I
sco

erfaces and Connections

Create Connection | Edit nterface/Connection

_JInterface and Connections
Create New Connecton

YT o
» G Router Select 8 connection o Case scenario |
@ Ehomet LAN LAN Wizard - GigabitEthemet0/1 T |
B & (@4 Unified Communicat tions  Eshemet (FARCE or
informaten .
IP address 192.168.0.1
Corfigum Biemad
Suetmask 7552552550 | o 24

TR r—

P Canfigurstion Editor

P Save Configuration ta PC

P Wiite to Startup Canfiguration

Freinet Create
¥ Reload Devies

»Bvien

Howdol:  How Dol Cof

<Back | Nen> | Finien | cancet| Help -

11. Select the radio button for “Yes” to enable the DHCP server and then click the
“Next >” button.



| Appication  Help

LG vere B | | % & 0 O

Salact Community Mambar:
€ Configure > Interf: > Interf:

Interfaces and Connections

Create Connection | EditintertacaiConnection |

N v £y interface Management
L] 1nterface and Connections.

&
i [enecywie e e use Case Scenario
» G Router
3 Security  Ethemet Lt LAN Wizard - GigabitEthernet0/1 . =)

€ Eihormet PPPoE o =

& (3 Unified Communications.
kormation Do youwant to enable @ DHCF server on your frusted LAN

Canfigura Ethamat interface 7

Note: Enabling a DHCP Server on your private natwsrk
allows you o automatically assign reusable P
addresses 1o DHCP clients o the network.

Flash Filo Managamant

/¥ Configuration Editor

[ #save configuration to PC

7 Write t Startup Configuration
Freinet Create tew Connectior

£#Raload Device
> Evien How do|

| <Back | Nest> | Finir | Cancetl| _Helo | | B

12. Enter the starting IP address in the “Starting IP” field, enter the ending IP
address in the “Ending IP” field and then click the “Next >” button.

o= % &= ’ 5 v i 3
| Q) teme [ 457 contgure || [ moniter w e O (2] Cisco Configuration Professional él;s'él:
Configure > >
erfaces and Connections
¥ B3 Interface Management
ST ane
i el Create Connection | Edit ]
[ Energywise e Use Case Scenario
¥ By Router Select a connection and dick Create New Connedtion
- TR e =)
_ e - ¥
»E1Tme (e -
» [0 Router Accass i Informaton Enter the IP address pool range for the DHCP Server. Choose starting and ending
f— Eordigin Hharl addresses for the DHCP Poal from the netwerkisubnet that this Interface belongs to.
o Itwill enable the DHCP clients in this network to lease the ip address from range
S

specified by starfing and ending IP address.
L) static and Dynamic Routs

> G DHCP Pool
»EIACL I
Qrar 1 Starting IF: 192166.0.10
[Qes
Ending IP: 192168050

b £ WARS Express

|} Router Provisioning

Fiash Fila Managamant
#Contiguration eaitor

#save Configuration to PG

7 write to Stamup Configurstion
et Creais How Conectcl

o Reload Devies

e

Howdol:  How Do | Cof

<Back| nen> | Fien | cancet| _wew | hl

13. Enteravalid IP address for the DNS server in the “DNS Serverl” field, leave
other fields as default and then click the “Next >” button.
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alial
CIsCo

terfaces and Connections
¥ B3 Interface [+]
R Create Connection | Edi Interface/Connection |
Greate New Connecton §
[ eneraywise Use Case Scenario
B Selac # connection and dick Creste Hew Connection
[ Router Options @ Ethemet LN [ | AN Wizard - GigabitEthernet0/1 - 8 )
c (PrPot o )
>ETime DHCP Options
» (& Router Access : infomaten
» GaoHCP Canfigurs Ethamat Configure the DHCP parameters like DNS Servers, Wins Servers and
s Domain Mame
[0 Static and Bynarmic Rout]
=
»Eiact I
nat —
j 1 ONsseneri(y 4222 WINS Serveri()
Gos
i DNS Server2(")y WINS Server2(")
[B) Rovter Provinicning. [
= Domain Name("):
= E
/7 Fiash Fls Management o S e
o/ Configuration Editer
/* Save Configuration to PC
/" Write to Startup Configuration
& Telnet Create New Connectiof
o Reload Device.
How 081" How Do | Cof |
|
<Back| Next> | fincn | Cancel| Help |

(2] Cisco Configuration Professional 'él"s"l'

¥ Einterface -

a i o | Creats Comection | Eatiterfacarcannaction |
Wi Creste Hew Comnecton o
i e
v B Router Setect 3 connecton ans alos Crasts New Connection
2 Router Options @emenetian | AN Wizard - GigabitEthemet0/L — prs—
»EaTime L2
1 (5 Routas Accass 3 Informstion | Sy
»EaoHce Gorfigurs Ethemell
e Please cick Finish (0 deliver o e router
R Stetic and Dynarmic Rout
Selected Interface ‘GigabitEthernet/1 - )
» 1A
»CaacL ‘ IP agaress : 192.168.0.1
= i Network Mast: 255 255 255.0
AT
L1Qes [DHCP Enabled true
Starting IP © 192.168.0.10
2 WARS Express Ending P 192.168.0.50
[0 Router Brovisioning || S Sy a
. 1 DNS Server2
5 WINS Servar1-
= WINS Server2

ion Editor

o canfigu
##Save Configuration 15 PG

P Wrbe to Startup Configuration
FTalnat Create Hew Connectiod

 Relosd Duvica

»Qavien

How dol:  How Do Cof

<Back | 11e- | Finish | cancel| weip |

15. Click the “Deliver” button.
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fact Community

P Configure > Interface Management > Tnterface and Connections

Interfaces and Connections
v Eyinterface Management |
b T Croate Connection | Edit Interface/Connection |

[ Energywise Create New Connectid | AN Wizard - GigabitEthemet0/1 =
v B Rouer Seiect s comnection ang

) Router Options

@ Etmet Lan

LAN Wizard Summary

" Etmarmat PPPoE o |

| eEaTime
N ot A i nformation Please click Finish o deliver to the router
¥ E50HCP Configurs Ethamst

Selected Interface ‘GigabitEthemet0/ B

(1) OHEP Posis

[} DHEP Bindings

Deliver Configuration to Device . ==

[} Loeal Posls

»GEaons f Deiver deta commands fo the device's running config.

L) Static and Dynamic Routi

rEARA
= description SETH-LANS.
rEa no shutgown
Qyrar p address 192.168.0.1 255.255.255.0 3
it B

Dees

o dhcp pool cep-poolt
network 192 168.0.0 255,255 255.0
4

ans-server 422
defoun-router 192.165.0.1 |
£Fiash Fie Managemant eaze 1

J Canfiguration Editor

/*Save Canfiguration ta PC The differences between the running configuration and the startup configuration are lost whenever

the device is turned off,

P Wiitm b Skartup Comfiguration
Palnat Create New Connecton|

™ Save running config to device's startup config. |
This operation can take seversl minutes.

FRaload Davica

»Qavien

Howdol:  How Dol Con

Dewver Cancel Save to fie Hep.

il
CIsco

B oner I ?!f U: (2] Cisco Configuration Professional

terfaces and Connections
¥ B3 Intarface Management
- Create Connection | Edit interfaceiConnesion |
) tntesface and Connectior| l

[ EnergyiWise LAN Wizard - GigabitEthemet0/L = ]

¥ 3 Router

L) Router Options Summary
>3 Time
» 03 Router Ac Plaase click Finish to deliver to the router

outer Access

v B3once

[Selected interface ‘GigabiEthemetor B
23 oHeP Pools
1] DHCP Bindings Deliver Configuration o Device
[ Local Poas -
Deliver deta commands to the device's running confiy.

»I0NS. I
All interfaces

[ Static and Bynamic Rout| FEpes Preview
=1 Interface/Con frtertace GipabtEmemettrt n
2 ‘description SETH LANS =
i — Commands Delivery St a
Rrar e 2000124 s Delwery Status
ex

Doss

o dhcp pool cop-pooll
= I etwork 192 163 0,0 2554 | Command Deivery Sistus:
= dns-server 4222
1921680, Tor devery. =
P Flash Fla Management loasz 1 Submiting 13 commands, piesse wat
o/ Configuration Editor i Bt
/*Save Configurstion to PC e |
o/ Writa to Startup Configuration the device is turned off il
2 Telnat ‘ ¥

I~ Save running config

e A
= of =

P Reload Devies

Bvien

Howdol: How DoCar

17. Navigate to “Configure”>”Unified Communications”>”” Unified
Communications Features” to make sure the radio button for “Cisco
Unified Communications Manager Express
and then click the “Apply” button.

" is selected. If not, select it




Cisco Configuration Professional

«  configure >

Selact router operating mode: Currently Ciaco Unified Communications Manager Express.

» i Interface Management (3) Cisco Unifisd Cammunications Manager Exprass
» 3 Router
B iy () Gatavay (Configura devica az MGCP/H.323/SIP Gatevay)
¥ £ Unified Communications
[ uniad Comminications Festiras
[[) Telephony Settings
[[) Advanced Telephony Settings
& (5 Users, Phones an. () Cisco Unified CME az SRST (Use in CME 2z SRST mode when link ko Cisco Unified Communication Manager is donn)
B ¥R Bettings (0 Mone (raze all the voica configuration on the davics)
3 Trunks
& (24 Dial Plans
» B4 Telaphony Features
1) Media Resources

1) unified Communications Security Audit

*Flash Fila Managamant

o Configuration Edibor

*5ave Configuration to PC

o wirte to Startup Canfiguration
Teiner

P Reload Deviee

»Bavien
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18. Navigate to “Configure”>”Unified Communications”>” Telephony

Settings” to configure the general settings.

a. Select “35 users” from the drop-down list of the “Maximum
number of Phones” field.

b. Enter the number of extensions needed in the “Maximum
Number of Extensions” field.

c. Select the date format in the “Date Format” field.
d. Select the radio button for the “Time Format” field.

e. Select the IP address for the GE 0/1 port from the drop-down
list of the “Phone Registration Source IP Address” field.

f. Enter “9” in the “Secondary dial-tone digit” field, leave other
fields as default.

g. Click the “Apply” button.
o Professic ,

W ronner | | e o O (2] Cisco Configuration Professional "':Il's'::l"

- ——
€ Colipunn 5 il Comssniestines 3 Talepluony Sattiogs

" Gisco Communications Manager Express version: 8.5
b (G Interface Mansgement

» (5 Router Maximum number of Phones *: —— =

> (53 Security Maximum Mumber of Extensions *: 4 number {1-200; no default)
¥ B3 Unified Camms
: men-dd-yy .

) Unified Co

ns Faaturas
L Telephany Setings
L) Advanced Telephony Settings

e hanas ard Bannalons Phans Registration Source IP Address =+ 192.160.0.1 (GigabitEthernatd/1) |+

[ vore settings

(@ 12 hour () 2% hour

4

Secondary diaktone digit: 7
» G Trunks
» (3 Dinl Plan=
8 Tolmplery Pombires L
[ Modi R
) Unified Communikations Sesurfy Audit
R Softkeys Settings
o — Ensble FXO hook flach for softiey bemplatas =]

I Enasla hurt graup lassut (Hiss) far softicey tamplates: | ]
Save Configuration to PC

/¥ Write to Stantup Configuration

FTeinet

£ Relasd Device *- indicates s mandatory field
»Evien




19. Click the “No” button.

Apphcation  elp

L) e Contigurs | [} Hemter

Select Communty Marmber

«

o101 |

il
cisco

& © Cisco Configuration Professional

192.168.0.1 (Gugabeti tharmato/1) | v

N Confirmation

Phones need to be resst for the following

canfiguration changes to take effect. They can
“ be reset now or you can reset them

Do you want to Reset tham now?

Seftieys Settmgs.

Enable hunt group logoul (Hiog) for softicey temg

Hoper
o
i &
Rpphcation  meip
/\g Home L'- Monitor | | ’Q’;’ ] Cisco Configuration Professional 'éll's'él‘;'

Select Community Member:
«

b (3 Interface Manag,

» 4 Router

| Telephony Settings

|} Advancsd Tslaphany Ssttings
b (53 Users, Phones and Extensions

Qyvete s

> B3 Trunks

» 3013l Plans

b (& Telaphony Features
[} Media Resources

1) Unified Communications Security Aud

Utilities.
# Flash File Managemant

“Can ion Editor

gu

#Save Configuration ta PC
[ Wirite to Startup Configuration
Telnat

Ralosd Davice

»Qvien

Configure > Unified Communications > Telephany Settings 2

Ganeral Settings

Cizcs Communications Manager Express version: 8.5

Maximum number of Phones *: | 35 users -
Maximum Number of Extansions * P number (1-200; no default)

Data Farmat mm-dd-yy

Time Format: 12 hour

24 howr

192.168.0.1 (GigabitEtherneto/1) | v

Falloning cammands will be applied to the device's running canfiguration.

ce IR Address =

Phane Registration So

Secondary dial-tone digit

telephany-service
ndany-disltone &

1p source-address 192.168.0.1

ma-dn 4

create cnf-files

exit

Softieys Settings
Enable FXO hook flash for s

Enable hunt group logaut (H

Running configuration wil b2 last unless it Is saved to start up configuration.

-~ Save

Save the configuration displayed above to your PC.

e As..

B ) (e

- Indicates a mandatary




21. Navigate to “Configure”>”Unified Communications”>"”Advanced

Telephony Settings” to configure the Web admin settings.
a. Select the “System Config” tab.

b. Enter the administrator’s username in the “System
Username” field.

c. Enter the password in the “System password” field.
d. Leave other fields as default and then click the “Apply” button.

welp

(o ]| B | % 6

(2]

Cisco Ci ation Pr

‘Select Community Membar:
“

Configure > Unified Communications > Advanced Telephony Settings.

» ﬁ Interface Management
» G Router
» G2 Security
¥ B3 Unified Communications
) Unified Communications Features
[3) Telephony Settings
] Advanced Telaphony Settings.
» (33 Users, Phones an:
() voIP Settings
» 53 Trunks
» (3 Dial Plans.
I Tatwphny Fasimes
) Media Resources

[} Unified Communications Sacurity Audit

¥ Flash File Management

£ Configucation Editor

/sava Configuration ta PC
/Wit to Stantup Configuration
P Tainet

JReload Davica

@ vien

Timeouts

Message displayed an phone:

Diractory naming schema:

Phone default I

Web admin settings
Configurs system and customer web administratar accaunt.
System usemame *1

System password *:

[] Enable customer wab account

Customer usarmamae:

Customer password:

andatory fiald

22. Click the “Deliver” button.

-~

¥ B3 Unified Co

o
[ Tele
L] Advanced Telephony Settings

» (£ Usars, Phones and Extensions

L) vote settings

» (1 Trunks

ons Security Audit

Write to Startup Configuration
P Tainat

#Reload Davice

> @vien

Application Help.
ols = : : 1
| G tome | [0 contare | BB wonitor ofo & (2] Claco C ation Pr vl
o cisco
Select Community Membaer:
,n — | - “  Configure > Unified Advanced
—_— — System Config | Timeouts  Dialplan Pattern  Transfer Pattern  Phane URLS
@ Message displayed on phonei
» B3 Router
g o Fiest Wamwe irst =
> B sesurity s T T
Music on holds ( 7

Phane default PIN:

Web admin settings
Configura systam and customs
System usemama *:

IR v nd will be spplied to the davice's running configuration.

L] Enable customer web acco

Customar ussmama:

Customar password

Running configuration will be lost unless it is saved to start up configuration.
Save Current Configuration to PC

Save the configuration displayed above to your PC.

Sava A




23. Navigate to “Configure”>”Unified Communications”>” Users, Phones and
Extensions”>“Extensions” to create extensions for routing inbound calls from
the SIP trunk.

a. Select the “General” tab to create a new extension.
b. Enter a new extension in the “Primary number” field.

c. Enter a DID assigned for routing inbound calls to this extension in
the “Secondary number” field.

d. Enter a descriptive name for displaying on the IP phone in the
“Name to be displayed on phone line” field.

e. Enter a description in the “Description” field.

f. Select “Do not register any number” in the “E.164
registration” field.

g. Leave other fields as default and then click the “OK” button.

| o & , ; : . .
{Q) Home || {C configure Monitor | | GP ¥4 © Cisco Configuration Professional 'Icllls'::lc;'
e % Configura > Unifiad Communications > Usars, Phones and Extansions > Extensions e
Primary wumbes | Labet user Line Hode
301 6316769380%301 DUAL o Rest s
02 eaersossinan ouaL N Restricians

General | Advanced

Primary number *: 303

Secondary numbers e |

v By Users, Phones

Hame to be displayed on phone line: [63156769582x303 |

P— o ]

] Block ealier I for ealls from this extension

| Line mode:
! Choose line mode to specify the number of active calls allowed on &
hd} phone button for this extension.
(#) Dusl-line (two simultaneous calls on an extension)
Flash Fils Managsmant
() Single-line (one call connection at  time)
Editor
() Octo-line (sight active calls on an extension)
Telnet * Indicates 3 mandatary field

Ralsad Davica

oK Cancel
_

Create... | | Edit.. | | Delate | dlone...

24. Click the “Deliver” button.




Home configure | Monitor Cisco Configuration Professional

1010101 ||

e Guided Configuration »

Fallowing commands will be 3pplied o the davice's running configuration. e e drenins =

<phone-dn 3 dusl-line.
fumber 303 secandary 6316769582 no-reg both
label 6316769582x303

deseription CME extension 303

it

Launch Wizaed.

Running configuration will be lost unless it is saved o start up configuration.
Save Current Configuration to PC

Save the configuration displayed above to your BC.

Save As...

Deliver cancel
Creata... Edit. Dalate Clone.

25. Navigate to “Configure”>”Unified Communications”>”Users, Phones and
Extensions”>“Phones” to add IP phones.
a. Click the “Add” button and from the “Setup a new phone” screen:
b. Select “7962” from the drop-down list of the “Type of
phone” field.
c. Enter the IP phone’s MAC address in the “MAC address” field.
d. Leave other fields as default and then click the “OK” button.

Application  Help

- ofe > - = =
) Home [ 5} contiawrs || @ wouitor | | oo 4 (2] Cisco € ation Pr il
e = < cisco
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PETETYINE « Configure > Unified Communications > Users, Phones and Extensions > Bhones e,
2 rove: retrieved Guided Configuration »
MAC Address PhoneT o= Fresm—
» (3 Interface Mansgemant - dis? =4 Import User. Phone.
saiesonasse | 7362 R e
+ 82 Router
cccomaiiaoer | 7362
» 82 securty

¥ £ Unified Commurications

] unified Com: tions Fasturas

Type of phone *:

MAC address *: ECcBE2112F43

[ Telephony Setting

Router's port phone Is connected to1 | Select .
Auto-line selaction: Enable v Save the template as &

Fsv (.cov) file to your BC
[] enable video support nd antar data

| MNight Service Click the ‘Launch
Nizard...' button to sta

Night service feature forwards incoming calls from unstaffed he Bulk Impod rd.
extensions during night service hours, to other designated
@R Trunks Ehones. This allows calls to = recepticnist, for sxamels, to be e
(53 Dial Plans forvarded to an employee on night shift. et
» &3 Talaphany Features || Enabla this phane to recave calls to unstafied extensions

| bedia Resoures (] Allow this phone to make blocked calls during after hours
Utilities.
|| Enable Remote Worker

Flash File Management

Remota worker configuration allows 1P phones or instances of
Cisco 18 Communicater from remate offica/home to connect
Save Configuration to PC to & Cisce Unified CME system over a WAN. The maximum
rumber of remate phanes that can be supparted iz
datermined by the available bandvidth.

uration Editor

Write to Startup Canfiguration
Telnet

Salact codec type: | G.711(54 Kbps) | v
Reload Device

»Gvien

Note: Codec G.729r8(8 Kbps) requires transcoding suppert

* Indicates 3 mandstory fisld

ox Cancel 8

26. Click the “OK* button.
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Setup a new phone (@]

of phona *: 7962 -

MAC address * ECCB.B211.2F43

Router's port phona is connactad to:

Auto-line selection Enable v

Ensble vides suppart

Night Service

ing calls from unstaffed
o other designate
for
Information

Firemware is not configured for
[ ——

Configure the phone firmvare from Phone
Firmuare sereen.

Salact sodec typa

Note: Codec G.7298(8 Kbps) requires transcoding support

oK Cancel |

27. Click the “Deliver” button.

Configure Bl ronnor

: - 2 = Ll
Cisco Configuration Professional ''! 1|

cisco

[ r0.10.10.1 - i Phon.
»

MAC Address Phone Type User Primar, e
Setup a new phone
Type of phone * 7962 -

MAC addrazs = ECCB.8211.2F43
Router's port phone is connacted to

Following commands vill be applied to the device's running configuration.

=phone 3

mac-address ECC8.8211.2F43
type 7962

auto-line

exit

Runring configuration wil be lost unlass & i= saved to start up configuration
Save Current Configuration to BC
Save the configuration displayed above to your PC.

Save As...

Deliver cancel

28. Navigate to “Configure”>”Unified Communications”>”Users, Phones and
Extensions”>“User Settings” to assign IP phones and extensions to users.

a. Click the “Create” button and select the “User” tab from the
“Create User” screen.

b. Enter a user ID in the “User ID” field.

c. Leave other fields as default and then click the “OK” button.
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[teasaea Iv] € Configure > Unified Communical tions > Users, Phones an i > Usar Sattings e
. 0 rova retrieved Guided Configuration »
User 1D | First Last Display | Extension Phone | MAC Mailbox
RS-k Mankscai Mame  Name  Name s Tvpe Address

TR _

- 1. Dovmload the Bulk Import
Phone / Extensions | 1120 beorlse
user / ©SV tamplste

User 1D *: cME30L

[A) Phones

First Hame:
] User Settings

Last Hame:

»GaTe

Display Namet

| Launch wizard...
Pazsward Ganaration: | Use Blank Password -

New Password:

Use Blank PIN -
New PIN: Blank Figured (4-8 digits)

Cenfirm PIN: Blank PIN configured (48 digits)

* Indicates s mandatory field

oK cancel

| create... |

29. Select the “Phone/Extensions” tab.

a. Assign the phone to the user by selecting the MAC address of the IP
phone from the drop-down list of the “Phone” field.

b. Select “1” from the drop-down list of the “Phone Line” field.

c. Assign the extension to the user by selecting the extension from the
“Available Extensions” box and then click the “>” button.

d. Leave other fields as default and then click the “OK"” button.

e aton My
oA o2e = - - -
Q) Home || (07 configuee || Il Manitor v ¢ ) cisco Configuration Professional *!l111l1s
* 3 = cisco 1'.
Select Community Membaer: y
1010101 |+ | ®  Configure > Unified Communications > Users, Phones and Extensions > User Settings @
e User 10
SO Tobn-fnce Maraarient
w Correct the following errors: @
» Errors detected in Phone / Extensions tab.
+ Corect the areas below the fields to sea details):
] User | Phone / Extansions | Mailbox
Phone *: [ECCB.8211.30EF(7962) | v
Phone Line: 1 A
Line Type: Regular B
] User setings Ring Behavicr: [ mormal B
» (53 Templates and Firmvare
[ vetp
» B3 Trunks Extensions
» 3 Dial Plans
» (23 Telephony Features fihow AR, z
[ Media Rasources Atiker
B e menupiest s S meury Available Extansions: Selacted Extensions:  Line # | Extension | Line/Ring Type
Uil T 302 ¥ 301 (CME3D1) 1 301 Regular/Normal
/*Flash Fila Managemant 2 203 3
Corfigurmtion EdHne < &
Siave Gl fig irationto PG 2] A
s
J*Wilte to Startup Configuration =
| s
Preinet
|
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oK Cancel
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30. Click the “No” button.

Cisco Configuration Professional *'lt+1ls
cisco
»
o
Phane *1 | Ecca.8211.2F43(7062)
(Eccesanrzrasireen [+ )
e = ‘
e
Confirmation
e e e ot
[ e e
St
Line # Extension Line/Ring Type
= T T | g
> 2
-
= .
B 2
(«] A
.
* Indicates 2 mandatory field
e
ha (i) | oansStin)

31. Click the “Deliver” button.

Ripteation oty
) Home Configura i3 Cisco Configuration Professional sl
-k s — . Cisco
10.10.101 |« | % Configure > Unified Communications > Usars, Phones and Extensions > User Settings 3
UserTD | Fiest | tast | Diplay | Extension| Phone | MAC | Waiibox
e | e s S Nype. | e
o - T [ —
efting: Phone *: ECCB.8211.2F43(7962) | v g
= Line Type: Regular - - bl
N G —— -

Following commands will be applied to the devics's running configuration.

ephone 3
lzphony Featurs: usarmame CME301
button

ified © curity Audi ephone-dn 1
@t
Utilities

- Running configuration wil be lost unless it is saved to start up configuration.

— Save Current ConfigurationtoPC

Sava the configuration displayed above to your BC.

Creats..

Detiver cancel




32. Navigate to “Configure”>”Unified Communications”>”VolP Settings” and
then click the “Edit” button to configure the VolP parameters.
a. Select the “General VolP Settings” tab, check the checkbox for
“Allow SIP to SIP connection”, leave the other fields as default and
then click the “OK” button.

EE—— R W=

) Heme R ronier | | o _:Q (2) Cisco Configuration Professional .ll'.‘ll'sl::o
Selact Communty Mamber

ey oo P
1010001 |+ Config

Apglication  Help

» 03 Intarface Managsment
[~ o =

1n order to connect twe disparate ValP networks, the device must be configurad to allow different types
of sndpoints to communicate. Selact from one of tha folloming options.

V] Allaw 51 10 S1P cannaston

(] Allow 1P to H.323 connaction

v (L] Allow H.323 o 51 connaction

Telephony Settings
B s (] Allow H.323 o H.323 connection

|} VotP Sattings
> 3 Trunks =
» (3 Dia! Plans
» (4 Telaphany Faaturas

[ Madia Razources I

[} unified Communications Security Audit

* Indicates & mandatory field |

| ok Cancel

33. Click the “Deliver” button.

Application  Help

} Home Configure || S )

by Memb

10.10.10.1 | v —
General VoIP Settings  SIP Settings  H.323 Settings

In order to connect two disparate VoIP networks, the device must be configured to allow diffarent types
of andpoints to communicate. Selact from one of the following options.

[¥] Allow SIP ta SIP connection
[] Allow SIP ta H.323 connection
fied Communications Fe (] Allow #.323 to SIP connection

(] Allow H.323 to H.323 connaction

Fallawing commands wil be applied to the device's running configuration.

voica serviea voip
exi

Utiities
Running configuration will be lost unless it iz saved to start up canfiguration.

Save Current Configuration to PC

Save the configuration displayed sbove to yeur PC.

| SaveAs.. |

Deliver Cancel
* indicates 2 mandstory feid |

B

[ ox Cancel g




34. Select the “SIP Settings” tab, check the checkbox for “Use SIP 302 moved
temporarily for call forwarding”, uncheck the checkbox for “Use SIP Refer for
call transfer”, leave the other fields as default and then click the “OK” button.

= : BN W W —
.

gy o - " = = |
) Home ‘ B vonitor | do & (2] Cisco Configuration Professional aluali
s . CISCO
Select Community Membar:
10.10.101 |+ € Configur
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= AR -
» 6 Router
» £ Securty 1f the peer VoIP device supports SIP Redirect and Refer messages, then this device can be enabled to
A use SIP Redirect messages for all forsarding and S1P Refer massages for cal wansfar, If this
e x functinality iz not enabled on thiz device, then calls hairpin through the device.
2 Unified Communicaions Faatures
(¥ vse SIP 302 moved temporarily for call forwarding
[ Felephony Settings
bl [[] Use SIB Refer for call transfar
B Advarcad Telashony Ssttings
- Users, Phanes and Exb
TR The SIP registrar accepts SIP Register messagas from local SIP phones.
» B2 Trunks san L] Enable local 1P registrar
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/¥ Configuration editor
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35. Click the “Deliver” button.
B oot I B :
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| |
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| Folloming commands il ba applied o the davice's running configuration.
o |
o supplementary-service sip rafer
-t
Uiiities [
I
" I
Write: & Startup Contiguest Aunning configurstion vl be lost unless it i3 saved ta start up configuration.
Save Current Configuration to PG
- Sava the configuration displayed above to your BC.
L save As.
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36. Select the “H.323 Settings” tab,
a. check the checkboxes for “Use H.450.2 protocol for call transfer”,
“Use H.450.3 protocol for call forwarding” and “Use H.450.7
protocol for call MWI”
b. leave other fields as default and then click the “OK"” button.
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v B | % 6

\ “ omae

Help

General VolIP Settings  SIPSettings | H.323 Settings

(2 interface Management

vo
» (23 Router |
b (2 Securty 1F the peer VoIP device supports H.450.2 and H.450.3, then this device can be configured to use H.450.2
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QRN ot i) calls hairpin though the device. |
Unified Commun
- [¥] Use H.430.2 protocel for call transfer
Telaphany Settings
< ait Use H.450.3 protocol for call forverd
1) Advanced Telaphony Setti B Des KA preteenl il Cemrchit
» £ Users, Phones and Ext
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Canfiguration Editer
Save Configuration to PC
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Reload Device

- Eyvien
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37. Click the “Deliver” button.
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Utsities
- Running configuration will be lost unless it = zaved to start up configuration.
E Save Current Configuration to PC
: Save the canfiguration displayed above ta your PC.
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38. Navigate to “Configure”>”Unified Communications”>”Trunks”>”SIP Trunks”
to configure Optimum Business SIP Trunk Adaptor as the SIP service provider.
a. Click the “Edit” button, select “-- Generic --“ from the drop-down

list of the “SIP Service Provider” field and select the
“General” tab.

b. Enter the “Primary Server” |P address. This is the IP address that
was assigned to the Optimum SIP Trunk Adaptor’s LAN interface.
This address was configured in Step 2 in the Optimum Business SIP
Trunk Set-Up Guide.

c. Enter the “Registrar” |IP Address if you are configuring the PBX for
SIP registration mode. This is the IP address that was assigned
to the Optimum SIP Trunk Adaptor’s LAN interface. This address
was configured in Step 2 in the Optimum Business SIP Trunk Set-Up
Guide. Leave this field blank if you are configuring the PBX for
static IP mode.

d. Enter the “Outbound Proxy” IP address. This is the IP address that
was assigned to the Optimum SIP Trunk Adaptor’s LAN interface.
This address was configured in Step 2 in the Optimum Business SIP

Trunk Set-Up Guide.

e. Enter the PBX’s GE 0/0 port’s IP address in the “SIP Domain
Name” field.

f. Enter a valid DNS IP address in the “DNS Service Address” field.

g. Enter the maximum number of concurrent calls allowed in the
“Maximum Number of Calls Allowed” field.

h. Click the “OK” button.

T e z = v ——— L

- o = =

Application  Help

Cisco Configuration Professional
cisco

2

SIP Service Provider : — Generic — -
General  Authentication  Advanced
Service Provider Server Settings Domain Name Service Settings

Enter 1P address or hustname of proxy and S DomainName :  to.10.10.1
regictrar carvers below.

ONS Server Addrass 1 4222

Brimary 10.10.10.2

Registrar ¢ 10.10.102

Outbaund Praxy ¢ 10.10.10.2

Maximum Number of Calls Allowed © 4 (1-10000)
Remote Party 1d
To zand caller nama information an all cutgoing calls on SIP Trunk enable remota party id

[¥] Enable remete party id

39. Click the “Deliver” button.
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Follaning commands il be applied to the device's running configuration.
General | Aut
vorce zarvice voip ]
t s
] service providl] | outbound-proxy ipv4110.10.10.2
1 et
exit
registrar ipva:10.10.10.2
ot
Outbound Pro
ip name-server 4.2.2.2 rl
call threzhold slosal total-calls low 2 bigh 4 -
Mairmurm tiumbs
Running configuration wil be lost unlass it is saved ko start up configuration.
Remote Party] o »
R Save Current Configuration to PC
Save tha configuration displayed above to your BC.
[#] Enable ram:
il Deliver | | Cancel

Edn Reset to default...

Note: This step is needed only if you are configuring the PBX for SIP
registration mode.

Click the “Edit” button, select “-- Generic —* from the drop-down list of the
“SIP Service Provider” field and select the “Authentication” tab.

a. Click the “Add” button to set up the PBX to send SIP registration for
the pilot DID. Note that the username and password must match
what has been configured on the Optimum SIP Trunk Adaptor. This
is step 3 in the Optimum Business Sip Trunk Set-Up Guide.

b. Enter the username in the “Username” field.

c. Enter the password in the “Password” field.

d. Enter the realm (if needed) in the “Realm” field.
e. Click the “OK" button.

40.
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41. Click the “Deliver” button.
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General | Authentication

entials usemams 5316769580 password 6316769380 realm 6316769580

Runring configuration will be lost unless it s saved to start up configuration.
Save Current Configuration to PC
Save the configuration displayed above to yaur PC.

|_saveas.

Delver | [ cancel
—_—

42. Navigate to “Configure”>”View”>”Running Configuration” to see if the
DHCP server on GE 0/1 interface (IP address of 192.168.0.1/24 in this example)
is set up to send “option 150” (TFTP server IP address) to the DHCP clients
when the IP phones are restarted. If “option 150” is not in the “ip dhep pool
ccp-pooll” section, the IP phones would not be able to retrieve the files created
for the IP phones by the PBX. To take care of this problem, enter the following CLI
commands from the console:

cisco2901cme#configure terminal

Enter configuration commands, one per line. End with CNTL/Z.
cisco2901cme(config)#ip dhcp pool ccp-pooll
cisco2901cme(dhcp-config)#option 150 ip 192.168.0.1
cisco2901cme(dhcp-config)#exit

cisco2901cme(config)#exit

cisco2901cme
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utilities > View > Running Configuration

Rezults of show running-canfig

Building canf

Current configuration : 7264 bytes
* Last configuration change at 21:17:48 UTC Men Jan 10 2011 by admin

version 15.1
ser mestamps debug datetime msec
zervice timestamps log datetime maec
ne service passverd-encryption

hostname cisco2501cme
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ip dhcp excluded-sddress 192.168.0.1 192.168.0.9
ip dhcp axcluded-address 192.168.0.51 192.168.0.258

S ip dhep poal cep-pool1
v Elvien
ntvari 192.168.0.0 255.255.255.0
2/ Running Configuration 2
108 Show Commands

Default Rul

43. Navigate to “Configure”>”Unified Communications”>”Dial Plans”>
"Codec Profiles” to group “g71lalaw” and “g71lulaw” into the same
codec class.

a. Click the “Create” button and from the “Create Voice Class
Codec” screen:

b. Enter “1” in the “Voice Class Codec Number” field.

c. Select the “g711alaw” codec from the “Available Codecs” list and
then click the “>” button.

d. Select the “g711lulaw” codec from the “Available Codecs” list and
then click the “>” button.
e. Click the “OK” button.
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44, Click the “Deliver” button.
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Running configuration will be lost unless # iz saved to start up canfiguration.
Save Current Configuration to PC

Save the configuration displayed abave £ your PC.

Save As...
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45. Navigate to “Configure”>”’View"”>”Running Configuration” to see if
EdgeMarc’s IP address is in the “ip address trusted list” under the “voice
service voip” section. If it is not there, inbound SIP calls from EdgeMarc will
be rejected by the PBX with a SIP “403/Forbidden” response. To take care
of this problem, enter the following CLI commands from the console:

cisco2901cme#configure terminal

Enter configuration commands, one per line. End with CNTL/Z.
cisco2901cme(config)#voice service voip
cisco2901cme(conf-voi-serv)#ip address trusted list
cisco2901cme(cfg-iptrust-list)#ipv4 10.10.10.2
cisco2901cme(cfg-iptrust-list)#exit
cisco2901cme(conf-voi-serv)#exit

cisco2901cme(config)#exit

cisco2901cme#
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Select Community Member.

Utilities > View > Running Configuration

Results of show running-tanfig
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46. Navigate to “Configure”>”Unified Communications”>”’Dial Plans”>"VolP”
to complete SIP trunk configuration for Dial Peer. Note that the first Dial Peer
entry was automatically created for incoming calls by the PBX when SIP trunk
was configured.
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47. Select the Dial Peer number 1 entry, click the “Edit” button and then select the
“General” tab to change some parameters and leave Dial Peer Number 1 for
incoming calls only.

a. Select “g711ulaw” from the drop-down list of the “Codec” field for
now as selection for “Voice Class Codec” is not yet available.

b. Select “rtp-nte” from the drop-down list of the “DTMF Relay Type”
field. This allows the PBX to relay outbound DTMF with RFC-2833
DTMF. Note that, for inbound DTMF, the PBX will recognize
RFC-2833 DTMF only.

c. Leave other fields as default and then click the “OK” button.
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48. Click the “Deliver” button.
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Sava the configuration displayed above to your PC.
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49. Select the Dial Peer number 1 entry

a. Click the “Edit” button and then select the “General” tab again
to choose the Voice Class Codec that includes both “g711ulaw”
and “g71lalaw”.
b. Select the radio button for the “Voice Class Codec”.
c. Select “1” from the drop-down list of the “Voice Class Codec” field
and then click the “OK" button.
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50. Click the “Deliver” button.
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51. Navigate to “Configure”>”’Unified Communications”>”Dial Plans”>”VolP”
to create a second Dial Peer for SIP trunk for outgoing calls only.

a. Click the “Create” button and then select the “General” tab.

b. Enter a description in the “Description” field.

c. Enter “9T” (9 followed any numbers) in the "Destination
Number” field.

d. Select the radio button for “Voice Class Codec” for the
“Codec” field.

e. Select “1” from the drop-down list of the “Voice Class Codec” field.

f. Select “rtp-nte” from the drop-down list of the “DTMF Relay Type”
field. This allows the PBX to relay outbound DTMF with RFC-2833
DTMF. Note that, for inbound DTMF, the PBX will recognize
RFC-2833 DTMF only.

g. Leave other fields as default and then click the “OK” button.
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53. Navigate to “Configure”>”’Unified Communications”>"”Dial
Plans”>”"Translation Rules and Profiles” to create an outbound rule for
removing SIP trunk access code before dialing.

a. Select the “Translation Rules” tab and click the “Create” button.

b. Enter “1” in the “Translation Rule Number” field.

c. Click the “Add Rule” button.

d. Enter “/A9\(.¥\)/” in the “Match Pattern” field to match a string of
numbers starting with a “9”.

e. Enter “/\1/” in the “Replace Pattern” field to replace the matched
numbers with the same numbers without the leading “9” digit.

f. Click the “OK” button.
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54. Click the “Deliver” button.
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Fallowing commands will be applied to the davice's running configuration.

[voica transiation-rule 1
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exit
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Running configuration will be lost unless it is saved to start up configuration.
Save Current Configuration ta PC
Sava the configuration displsyad abov ta your BC.
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55. Navigate to “Configure”>”Unified Communications”>” Dial
Plans”>”"Translation Rules and Profiles” to create a Translation Profile to hold
the Translation Rule for the called number.

a. Select the “Translation Profiles” tab and click the “Create” button.
b. Enter a descriptive name in the “Translation Profile Name” field.

c. Select “1” (Translation Rule #1) in the “Called number Rule” field.
d. Leave other fields as default and then click the “OK” button.
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56. Click the “Deliver” button.
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o7.

Navigate to “Configure”>”Unified Communications”>"”Dial

Plans”>”"Translation Rules and Profiles” to create outbound rules for

configuring caller ID.
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a. Select the “Translation Rules” tab and click the “Create” button.
b. Enter “2” in the “Translation Rule Number” field.

c. Click the “Add Rule” button.

d. Enter “/A30[1-3]/" in the “Match Pattern” field to match all the
extensions starting with a “3”, “301”, “302"” and “303".

e. Enter “/6316769580/” in the “Replace Pattern” field to replace
each extension with the pilot DID. Note that this example is for
SIP registration mode where only the pilot DID can be used as the
caller ID. For static IP mode where each extension may use its
assigned DID as the caller ID, different translation rules will be
needed for mapping all the extensions with different caller ID.

For example, to map extension “303” with caller ID of
“6316769582”, set the “Match Pattern” to “/A303/” and set the
“Replace Pattern” to “/6316769582/".

f. Click the “OK"” button.
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58. Click the “Deliver” button.
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Running canfiguration wil be lost unless it is savad to start up configuration.
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Sava the configuration displayed above to your BC.
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59. Navigate to “Configure”>”Unified Communications”>”Dial
Plans”>”Translation Rules and Profiles” and select the “Translation
Profiles” tab to add Translation Rule #2 for the calling number to the
same Translation Profile.
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a. Select the Translation Profile and then click the “Edit” button.
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b. Select “2” (Translation Rule #2) in the “Calling number Rule” field.
c. Click the “OK” button.

PR e AW T W e

Q) tome | L"u";mnsm | B monitor | o & 0 O Cisco Configuration Professional "':1"5'":2'

@

Select Community Mambar:

10.10.10.1 | v “ configure > Unified Communications > Dial Plans > Translation Rules and Profiles

Translation Rules  Translation Profiles
v B tnterface Management . =
| 1 rovs retrieved
) Intarface and Cannactions
<Ll Translation Profile | Callod Number Rule | Calling Number Rule | Redirect Called Radiract Targat

oo Name. Number Rule Number Rule
* G Router SIR Trunk Rules 1
=1 ty

¥ £ Unifisd Communications
[3) Unified Communications Features
[} Telephony Settings
) Advanced Telephony Sattings
¥ (3 Users, Phanes and Extansions

[ vatP Settings
(1~ 31 characters)

Translation Profile Name * Trunk_Rules

v B Trunks

(st Tun I Called number Rule:

v E50ial Plans
Calling number Rule:

Qrots
[verw Rediract Called number Ruls:
] Translation Rules and Profiles Rediract transferto/formard-final Rurmber Rules  [(ame

Calling Restrictions
- * Indicates 2 mandatory field

() Codec Profiles

» (53 Talephany Featuras

) Media Resources v}

Utilities.

Canfiguration

Save Canfiguration to PC

Writa to Startup Configuration

Telnet
Create.
Reload Device | [ B

T T L=

|| Edite. Delete




60. Click the “Deliver” button.
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61. Navigate to “Configure”>”Unified Communications”>”Dial Plans”>
"VolIP” to apply the Translation Profile and its Translation Rules to
the outbound calls.
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a. Select the Dial Peer #2 (“Outgoing calls to SIP trunk”) and then
click the “Edit” button.

b. Select the “Digit Manipulation” tab from the “EditVolP Dial
Peer” screen.

c. Select the translation profile (“SIP_Trunk_Rules”) from the drop-
down list of the “Translation Profile for Outgoing Calls” field.

d. Click the “OK” button.
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62. Click the “Deliver” button.
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63. Navigate to “Configure”>”View”>”Running Configuration” to see if the
“transfer-pattern 9T” and “transfer-system full-consult” commands are set
up under the “telephony-service” section. If these commands are not there, you
cannot dial the “9” access code to transfer a LAN-to-WAN call to another WAN
phone. To take care of this problem, enter the following CLI commands from the

console:

cisco2901cme#configure terminal
Enter configuration commands, one per line. End with CNTL/Z.
cisco2901cme(config)#telephony-service
cisco2901cme(config-telephony)#transfer-pattern 9T
cisco2901cme(config-telephony)#transfer-system full-consult
cisc02901cme(config-telephony)#exit
cisco2901cme(config)#exit

cisco2901lcmet#
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Note: The Cablevision network only supports inband DTMF tones. The Cisco
CME PBX only supports out-of-band DTMF tones. In order for the Cisco CME
PBX to operate correctly with the Cablevision network, the Optimum SIP Trunk
Adaptor must be configured to convert out-of-band DTMF tones sent by the
Cisco CME PBX to inband DTMF tone.




64. To enable this conversion, log into the Optimum SIP Trunk Adaptor using the login
and password specified in the Optimum SIP Trunk Adaptor
Set-Up Guide.
a. On the SIP Trunk Configuration page, you must check the “Convert
Inband DTMF” checkbox.
b. Click the “Submit” button to update this setting.
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